
 
 

 

 ISE 14.5بر اساس نسخه                                                ISEراهنمای استفاده از نرم آفزار 

 

 ISEراهنمای استفاده از نرم افزار   
 ISE 14.5نسخه بر اساس 



 
 

 

 ISE 14.5بر اساس نسخه                                                ISEراهنمای استفاده از نرم آفزار 

 

 

 

تهیه شده است.  Xilinxمتعلق به شرکت  ISEافزار رو برای آموزش کار با نرمراهنمای پیش

دانشگاه تهران است. هر گونه تکثیر از این اثر منوط به  ICEEPکلیه حقوق این اثر متعلق به گروه 

 باشد.می ICEEPی کتبی پدیدآورندگان این راهنما در گروه اجازه



 

   3 Copyright © 2013 ICEEP, University of Tehran                                                           

 

 فهرست

 8 ..................................................................................................................................... شگفتاریپ :1 فصل

 11 .................................................................................................................... افزارنرم یکل مرور :2 فصل

 ISE ............................................................................................................ 11 تگریهدا واسط -2-1

 12 ......................................................................................................................... یطراح قاب -2-2

 ISE ............................................................................................................. 13 در پروژه لیفا -2-3

 11 ............................................................................................................................ نصب مراحل :3 فصل

 HDL.......................................................................................................... 23 اساس بر یطراح :4 فصل

 ISE ..................................................................................................................... 24 کردن باز -4-1

 24 ............................................................................................................. دیجد پروژه ساخت -4-2

 28 ....................................................................................... پروژه به یطراح لیفا کردن اضافه -4-3

 32 ........................................................................................................................ سنتز اتیعمل -4-4

 33 ........................................................................................................ کیشمات اساس بر یطراح :1 فصل

 43 ................................................................................................................... یرفتار یساز هیشب :6 فصل

 ISim ............................................................................................................ 44 با یساز هیشب -6-1

 Modelsim .................................................................................................. 46 با یسازهیشب -6-2

 14 ................................................................................................................................. یسازادهیپ :3 فصل

 16 ....................................................................................................................... هیپا صیتخص -3-1

 15 ..................................................................................................................... برد یزیربرنامه -3-2

file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473056
file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473058
file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473062
file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473063
file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473068
file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473069
file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473072


   ISEراهنمای استفاده از نرم افزار 

 

 

4 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 63 ................................................................................................................................................. نامهواژه 

 

  

file:///C:/Users/EbLi/Desktop/ISE/ISE_QuickStart2.docx%23_Toc370473075


   ISEراهنمای استفاده از نرم افزار 

 

 

1 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 هافهرست شکل

 ISE ......................................................................................................... 12 تگریهدا واسط 

 18 ........................................................................................ افزارنرم نصب یبرا هیاول پنجره 

 Xilinx  (1) ............................................. 15 شرکت مقررات و نیقوان به به مربوط پنجره 

 Xilinx  (2) ............................................. 15 شرکت مقررات و نیقوان به به مربوط پنجره 

 21 .......................................................................................................... نصب نهیگز انتخاب 

 21 ................................................................................................... نصب یهانهیگز انتخاب 

 22 ...................................................................................................... نصب ریمس مشخصات 

 24 ........................................................................................................ پروژه تگریهدا کونیآ 

 26 .................................................................................... دیجد یپروژه ساخت هیاول پنجره 

 23 .................................................................................................... پروژه ماتیتنظ یپنجره 

 28 .................................................................................................. پروژه ماتیتنظ یخلاصه 

 25 ..................................................................................... موجود ای دیجد منبع کردن اضافه 

 31 ................................................................................ مدار یهایخروج و هایورود نییتع 

 31 .................................................................................. شده اضافه منبع مشخصات خلاصه 

 Verilog ........................................................................................................ 32 لیفا قالب 

 33 ................................................................................................... یاصل واحد RTL ینما 

 34 ................................................................................................... اتیجزئ با RTL ینما 



   ISEراهنمای استفاده از نرم افزار 

 

 

6 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 RTL View ............................................................................ 31 در یطراح یهایژگیو

 36 ................................................................................ هاگزارش و یطراح خلاصه یشما 

 38 ......................................................................................................... کیشمات پروژه جادیا 

 35 .................................................................................................. کیشمات یطراح یپنجره 

 41 ............................................................................................ هاکتابخانه از هاالمان انتخاب 

 41 ............................................................................................. هایخروج و هیورود نییتع 

 42 ................................................................................................. کنندهجمع یینها کیشمات 

 ISim ..................................................................................................................... 41 طیمح 

 43 ............................................................................................................... هایژگیو انتخاب 

 43 ................................................................................................... ستمیس ماتیتنظ انتخاب 

 48 ................................................................................................................ طیمح یهاریمتغ 

 Path ............................................................................................................. 45 ریمتغ میتنظ 

 11 ............................................................................................................... سازهیشب  انتخاب 

 ISE ........................................................................................... 11 به Modelsim یمعرف 

 12 ........................................................................................................ هاکتابخانه یسازهیشب 

 Modelsim ............................................................................................... 13 با یسازهیشب 

 Modelsim .................................................................................... 13 یپنجره از ییشما 

 11 ...................................................................................... خطا بدون یطراح و سنتز ندیفرآ 

 16 ....................................................................................................... یساز ادهیپ لیفا دیتول 



   ISEراهنمای استفاده از نرم افزار 

 

 

3 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 Floorplan ...................................................................................................... 13 کردن باز 

 Package .............................................................................................................. 13 پنجره 

 18 .................................................................................................................... هیپا صیتخص 

 15 ....................................................................................................................... هیپا گزارش 

 61 ........................................................................................................ یبندئتیه نوع نییتع 

 iMPACT ..................................................................................................... 61 کار پنجره 

 61 .................................................................................................................. دستگاه انتخاب 

 62 ...................................................................................... مقصد دستگاه یرو یزیربرنامه 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 فصل اول

 پیشگفتار

 



 فصل اول: پیشگفتار                                                         ISEراهنمای استفاده از نرم افزار 

 

 

5 Copyright © 2013 ICEEP, University of Tehran                                                            

 

خواهیم  Xilinx ISE Design Suite افزارنرماستفاده از  یدر این راهنما به بررسی نحوه

ی هاکار با بخش ینحوهپرداخت. برای این کار از توضیح نصب برنامه شروع کرده و قدم به قدم با 

 شویم.میمختلف آشنا 

آشنا نبوده و یا افرادی  افزارنرمبدیهی است گفتار پیش رو برای آن دسته از افرادی که با این 

 هستند مفید خواهد بود. افزارنرمکه خواهان بازیابی اطلاعاتشان در مورد این 

 3دهد. فصل میارائه  ISE افزارنرممروری روی  2فصل  .فصل خواهیم داشت 6در ادامه 

شوید، میبا مبانی ایجاد یک طراحی آشنا  1و  4در فصل دهد. میافزار را آموزش نصب نرم یطریقه

 3فصل  یآموزید و در نهایت با استفاده از راهنمایمیسازی طراحی را روش شبیه 6در فصل 

 سازی طراحی را فرا خواهید گرفت. پیاده



 

 

 : 1 فصل

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 فصل دوم

 افزارمرور کلی نرم
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 (Integrated Software Environment) ISE های یک ابزار برای سنتز و آنالیز طراحی

 Xilinxافزار متعلق به شرکت باشد. این نرمافزاری میهای سختتوصیف شده توسط یکی از زبان

 های آن را به صورت زیر خلاصه نمود.توان قابلیتبوده و به طور کلی می

 ها امکان سنتز یا کامپایل طراحی 

 هاآنالیز زمانی طراحی 

 1های بررسی دیاگرامRTL   

 های مختلفسازی عملکرد طراحی در ازای ورودیشبیه 

 ریزی دستگاه مقصدپیکربندی و برنامه 

 پردازیم.می افزارنرمدر ادامه به بررسی کلی این 

 2ISEدایتگر واسط ه -2-1

، 3منابعهای باشد که با نامی اصلی میدارای چهار پنجره ISE در حالت کلی واسط هدایتگر

نشان داده شده  1-2اند. این چهار قسمت در شکل شناخته شده 6کار فضایو 5رو نوشت ، 4فرآیندها

 است. 

                                           
1 Register Transfer Level 

2 Project Navigator Interface 

3 Source 

4 Processes 

1 Transcript 

6 Workspace 
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 ISEواسط هدایتگر  

 طراحی قاب -2-2

 پردازیم.میی مختلفی است که در ادامه به توضیح هر یک هاقاب طراحی شامل پنجره

 منابع یپنجره 

انتخاب شده برای سنتزِ  چنین نوع دستگاههای متعلق به آن و همنام پروژه به همراه فایل

 شوند.طراحی موردنظر در این پنجره نمایش داده می

 ی فرآیندهاپنجره 

 دهد.توانند اجرا شوند را نشان میفرایندهای موجودی را که برای یک فایل انتخابی میتمام 
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 ی رونوشتپنجره 

های موجود در طراحی که مانع تکمیل فرایند سنتز خطاهای مورد نیاز برای طراح از قبیل پیام

ها، سنتز ف نمودن آنتواند با برطرشوند و بدین ترتیب طراح میباشند، در این پنجره نشان داده میمی

 مدار خود را با موفقیت به اتمام برساند. 

 

 فضای کار یپنجره  

در حقیقت این بخش، محیط کار طراح بوده و توصیف مدار یا طراحی شماتیک موردنظر او 

 شود.هم اتلاق می HDL Editorگیرد. به این پنجره در این قسمت انجام می

 ISEفایل پروژه در  -2-3

 1پروژههای ذکر شده، نیاز به ایجاد ساختاری به نام برای استفاده از هر یک از قابلیت

دهی های طراحی را در قالب این ساختار مدیریت و سازمانباشد. در حقیقت این ابزار، المانمی

ه  ی مربوط به طراحی از قبیل اطلاعات نسخهااست که تمام داده XMLفایل پروژه، یک فایل  کند.می

را در اختیار دارد. این فایل توسط  ی طراحی و فرآیندهاپروژه، ویژگی منبعی ها، فایلISE افزارنرم

  . کندمیتغییر  منبع یهافایلهدایتگر پروژه خوانده شده و تنها با تغییر 

 3و یا شماتیک 2HDLافزار به دو صورت ها در این نرمتوان گفت که طراحیبه طور کلی می 

افزار همانند های توصیف سختتوانید طراحی خود را با یکی از زبانبه این معنا که می هند بود.خوا

                                           
1 Project 

2 Hardare Design Level 

3 Schematic 
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Verilog  و یا VHDL ی های آماده در کتابخانهکه از کنار هم قرار دادن المانتعریف نمایید و یا آن

ساختن  یدر فصول آینده نحوه کنید. افزار، یک شماتیک از طراحی مورد نظر خود تهیهموجود در نرم

  کار با آنها را بررسی خواهیم کرد. یو نحوه هاهر کدام از این پروژه



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 فصل سوم

 مراحل نصب
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دانید این پردازیم. همان طور که میمی ISE افزارنرمتصب  ینحوهدر این فصل به توضیح 

افزار ی نرمتوان به جدیدترین نسخهباشد.از طریق لینک زیر میمی Xilinxزار متعلق به شرکت افنرم

ISE ی دسترسی پیدا نمود. نسخهWebpack نخواهد  1افزار رایگان بوده و نیازی به مجوزاین نرم

را  Xilinx 2هایریزی تعداد محدودتری از دستگاهافزار امکان سنتز و برنامهداشت. این نسخه از نرم

در این نسخه قابل دسترس  ،و خروجی ورودیهای با تعداد زیادی آورد؛ در عمل دستگاهفراهم می

 نخواهند بود.  

http://www.xilinx.com/products/design-tools/ise-design-suite/ise-webpack.htm 
 

جا که این باشد ولی از آنمی ISE 14.6افزار، ی ارائه شده برای این نرمآخرین نسخه

بهره بردیم که در حال  ISE 14.5ی ه تازگی به بازار عرضه شده، در این راهنما از نسخهمحصول ب

 .باشدی پایدار این محصول میحاضر جدیدترین نسخه

سه گزینه برای نصب در اختیار شما قرار داده شده است که  ISE Design Suiteبرای دانلود 

 اب نمایید:ها انتختوانید هر یک از آنبر اساس نیاز خود می

 افزار در قالب یک فایل ی کامل نرمبستهDVD 

 عامل افزار متناسب برای سیستمی کامل نرمبستهLinux 

 عامل افزار متناسب برای سیستمی کامل نرمبستهWindows 

 نماید:های زیر را ساپورت میعاملتنها سیستم Xilinxشایان ذکر است که 

 Microsoft Windows 

 Windows XP Professional (32-bit and 64-bit), English/Japanese 

                                           
1 License 

2 Device 

http://www.xilinx.com/products/design-tools/ise-design-suite/ise-webpack.htm
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 Windows 7 Professional (32-bit and 64-bit), English/Japanese 

 Windows Server 2008 (64-bit) 

 Linux 

 Red Hat Enterprise Workstation 5 (32-bit and 64-bit( 

 Red Hat Enterprise Workstation 6 (32-bit and 64-bi) 

 SUSE Linux Enterprise 11 (32-bit and 64-bit) 

 به ترتیب زیر عمل کنید:  افزارنرمبرای نصب 

را اجرا  xsetup.exeآن فایل را از حالت فشرده خارج کرده و سپس فایل ابندا   .1

 نمایید. 

اید، فایل با در صورتی که فایلِ نصب را در قالب چندین بخش دریافت نموده: 1نکته

را اجرا نمایید. در این حالت نیازی  xsetup.exeحالت فشرده خارج نموده و سپس  را از  tar.پسوند

 نخواهید داشت. ی فشردههاکردن دیگر فایل بازبه 

در آن  xsetup.exeافزار را در اختیار دارید به دنبال فایل این نرم DVDدر صورتی که : 2نکته

 بگردید.

نامه از شما گرفته شده و به دنبال آن ی نصب بر، اجازهxsetup.exeبا اجرای فایل   .2

Wizard .برنامه نمایش داده خواهد شد 
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 افزارنرمپنجره اولیه برای نصب  

به نمایش   Xilinxی مربوط به قوانین و مقررات شرکت پنجره 1بعدیی با انتخاب گزینه

ی بعدی نصب یابی به مرحلهراهشرایط تعیین شده، امکان میتما با درآمده و تنها پس از موافقت

 شود.فراهم آورده می

 

                                           
1 Next 
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 Xilinx  (1)پنجره مربوط به به قوانین و مقررات شرکت  

 

 Xilinx  (2)پنجره مربوط به به قوانین و مقررات شرکت  
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ی موردنظر در این گام نیاز به انتخاب گزینهپس از انجام مراحل اعلام موافقت،  .3

که  ISEی ی قابل استفادهباشد. به این معنا که برای دسترسی به نسخهبرای نصب می

را انتخاب  ISE Webpackبایست نداشته باشد، در این مرحله می مجوزنیاز به 

 نمایید.

 

 انتخاب گزینه نصب 

ایند نصب در نظر گرفته شده است که ی انتخابی در طول فرچندین گزینهدر ادامه  .4

ی آن نصب در صورت انتخاب شدن، پس از اتمام نصب اصلی برنامه در ادامه

 خواهند شد.
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 های نصبانتخاب گزینه 

گردد. علاوه بر ی موردنظر برای نصب برنامه از شما درخواست میسپس پوشه .1

چنین میزان فضای همتعیین مقصد برنامه، میزان فضای مورد نیاز برای نصب آن و 

ز تعیین مقصد شوند. پس اانتخابی شما نمایش داده می دمقصموجود بر روی 

 را انتخاب نمایید. نصبی مناسب خود، گزینه
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 مشخصات مسیر نصب 

در نهایت مراحل نصب برنامه با موفقیت به پایان  1ی اتمامبا تکمیل روند بالا و انتخاب گزینه

 رسد.می

                                           
1 Finish 



 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 چهارمفصل 

طراحی بر اساس  

HDL 
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برای کنیم. را طی می HDLافزاری بر اساس یک واحد سخت فرآیند طراحی ،در این فصل

توانید کنیم. با این مثال به راحتی میرا انتخاب می 1کامل یکنندهجمع مانند این کار یک مثال ساده

ی خود را با مدار تولید شده بیابید. در این مثال، ما از زبان توصیف ارتباط کُد نوشته شده

ایم. لازم به ذکر است که مراحل لازم برای سنتز، برای مدار خود بهره گرفته Verilogافزاری سخت

 باشند.مستقل از زبان انتخاب شده می

 ISEباز کردن  -4-1

دو بار کلیک کنید و یا از طریق مسیر زیر  1-4روی آیکون به شکل   ISEبرای شروع کار با 

 هداتیگر پروژه را باز کنید.

Start > All Programs > Xilinx Design Tools > ISE Design Suite 14.5 > ISE 

Design Tools > 64 (32)- bit Project Nevigator 

 

 ن هدایتگر پروژهآیکو 

 ساخت پروژه جدید -4-2

File > New Project Wizard  توان با می  کند.ی مربوط به ساخت پروژه را باز میپنجره

                                           
1 Full Adder 
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نیز به آسانی به این پنجره راه یافت.  2در قسمت دستورات پروژه  1ی جدیدپروژهاستفاده از دستور 

گردد. ی موردنظر از شما درخواست می، اطلاعات لازم برای ساخت پروژهی جدید پروژهبا انتخاب 

چنین تعیین نوع فایل ورودی ی آن و هماین اطلاعات شامل نام پروژه، محل مناسب برای ذخیره

 توان هنگام ساخت پروژه، توضیحی نیز برای آن در نظر گرفت.یباشد. در صورت نیاز ممی

افزار امکان انتخاب چهار نوع فایل لازم به ذکر است که در زمان ساخت پروژه، این نرم

 کند:را برای طراح فراهم می ورودی

 HDL 

باشد، این گزینه می VHDLو یا  Verilogهای که فایل ورودی شما یکی از فایل در صورتی

 خود انتخاب کنید.  3ا برای واحد اصلی طراحیر

 شماتیک 

 باشد از این گزینه استفاده نمایید.شما یک فایل شماتیک می ورودیدر صورتی که فایلِ 

 4EDIF 

کند. این فرمت، یک فرمت واحد را به صورت فرمت استاندارد در صنعت مشخص می

ابزار دیگری تولید شده و نهایتاً  به پروژه بایست توسط باشد که میطرف و خنثی برای سازنده میبی

 اضافه گردد.   

 1NGC/NGO  

بایست کند. این فایل میمشخص می Xilinxماژول را به صورت یک فایل با فرمت مختص 

                                           
1 New Project 

2 Project Commands 

3 Level Design -Top 

4 Electronic Data Interchange Format 

1 Xilinx Native Generic Database 
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یا  CORE Generatorتولید شود )مانند  Xilinxشرکت  1IPی توسط یکی از ابزارهای تولیدکننده

System Generator  برایDSPافزار که به صورت مستقیم توسط نرمیا این ( وXST (Xilinx 

Synthesis Technology)    .تولید گردد 

 

 ی جدیدپنجره اولیه ساخت پروژه 

ی ساخت پروژه راه خواهید یافت. در این ی بعدی به گام بعدی از مرحلهانتخاب گزینه با

قسمت لازم است تا با در نظر گرفتن دستگاه مقصد مورد نظر خود، اطلاعات لازم جهت تعیین بُرد را 

چنین وارد نمایید. در این پنجره علاوه بر مشخصات دستگاه مقصد، لازم است تا ابزار سنتز و هم

                                           
1 ropertyIntellectual P 
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که در اختیار قرار داده  1سازهاییتعیین کنید. در میان شبیه ی خود را نیزساز مورد نظر برای پروژهشبیه

و  Modelsimکه بوده در حالی Xilinxساز شرکت شبیه ISim (ISE Simulator)شده است،   

Questa سازهای متعلق به شرکت شبیهMentor Graphics باشند.  می  

 

 ی تنظیمات پروژهپنجره 

آید. به نمایش در می ای از تنظیمات پروژهی بعدی، خلاصهکلیک بر روی گزینهدر نهایت با 

ی اتمام را انتخاب نمایید و در گزینه ،باشدی شما میتنظیمات، مطابق با خواستهمیکه تمادر صورتی

                                           
1 Simulator 
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 بیان نمایید. 1ی لغوی مسیر با گزینهغیر این صورت، انصراف خود را از ادامه

 

 ی تنظیمات پروژهخلاصه 

 اضافه کردن فایل طراحی به پروژه -4-3

کامل توصیف شده به زبان  یکنندهجمعر که اشاره شد، فایل ورودی ما یک همان طو

Verilog باشد. برای سنتز این مدار لازم است که یک فایل میHDL و ی خود اضافه کرده به پروژه

 .سپس کُد مربوط به آن را بنویسیم

                                           
1 Cancel 
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را انتخاب نمایید.  1ی منبع جدیدمنظور بر روی پروژه کلیک راست کرده و سپس گزینهبدین 

جا که فایل شود که نوع فایل ورودی خود را تعیین کنید. از آنبا انتخاب این گزینه از شما خواسته می

را در قسمت مربوطه انتخاب  Verilog Moduleخواهد بود، HDL Verilogما یک واحد  ورودی

  گذاریم.و نام مناسبی را که بیانگر محتوای این فایل است، روی آن می  کرده

 2ی منبع جدید، افزودن منبعباشد به جای گزینهدر صورتی که فایل موردنظر شما موجود می

 را انتخاب نمایید. 

 

 

 اضافه کردن منبع جدید یا موجود 

خود را خواهید داشت. نام  واحد اصلیهای ی بعدی، امکان تعیین پورتبا رفتن به مرحله

                                           
1 New Source 

2 Add Source 
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 گام بعدی بروید. ها را تعیین کرده و سپس به یا خروجی بودن آن ورودیچنین های مدار و همپورت

 

 های مدارها و خروجیتعیین ورودی 

شود تا در صورت نیاز به ی اطلاعات وارد شده، نمایش داده میی بعد نیز خلاصهدر مرحله

ی اتمام را ی مسیر خودداری کرده و در غیر این صورت نیز گزینهها از ادامهتغییر هر یک از آن

 برگزینید.
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 اضافه شدهخلاصه مشخصات منبع  

که برای آن میو با نا Verilogبا فرمت کُد  HDLبا اتمام ساخت فایل جدید خود، یک فایل 

ها دی یا خروجی بودن آنهای انتخاب شده و نیز نوع ورورتگردد. نام پواید، ایجاد میتعیین کرده

 شود. نیز در این فایل دیده می

 باشد: در حالت کلی این فایل شامل دو بخش می

 1قالب بلوک توضیحات 

هایی که ساخته این قسمت تنها برای خوانایی بهتر مدارات و مدیریت هر چه بهتر فایل

ها تأثیر در نظر گرفته شده است. پر کردن فیلدهای این بخش در مستندسازی بهتر فایل ،شوندمی

                                           
1 eemplatTlock BComment  
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 بسزایی خواهد داشت.

 1شرح واحد 

گیرد. مابین د نظر شما قرار میتوصیف ساختاری یا رفتاری مدار مور این بخشدر 

“module”  و“endmodule”  هر مدارVerilogتواند قرار بگیرد. در این ای که مد نظر شما باشد، می

 دهیم.را در این محدوده قرار می کنندهجمعمثال رفتار یک 

 

 Verilogقالب فایل  

 عملیات سنتز -4-4

به شما در پیداکردن  ISEدر صورتی که اشکالی در آن وجود داشته باشد  پس از نوشتن کد،

                                           
1 Module Statement 



 HDLچهارم: طراحی بر اساس فصل                                    ISEراهنمای استفاده از نرم افزار 

 

 

33 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 ها کمک خواهد کرد.آن

دوبار کلیک کرده و یا آن که  1سنتز ها یا بر رویفرآیندی مربوط به برای سنتز مدار، در پنجره

شود ندی میرا انتخاب نمایید. این گزینه منجر به آغاز فرای 2اجرابا کلیک راست بر روی این گزینه، 

آن را بررسی کرده و اعلام  ،و ساختار 3ترکیبکه مدار شما را آنالیز کرده و از نظر درستی ارتباطات، 

 <-  Synthesize-XSTگفتنی استباشد یا خیر. دارد که آیا مدار توصیف شده قابل سنتز میمی

Check Syntax   د.آورمدار را برای شما فراهم می ترکیبامکان بررسی درستی 

تولید شده از  4RTL نمای توانیددر صورتی که فرایند سنتز، بدون اشکال به پایان برسد می

 <-  Synthesize-XST توانید از طریق می.این کار را مدارتان را به طور گرافیکی مشاهده نمایید

View RTL Schematic به صورت زیر کنندهجمع . شماتیک تولید شده برای مثال انجام دهید 

این . با کلیک بر روی شود مینمایش داده های آن پورت و مدار واحد اصلیابتدا  در باشد کهمی

 گردد.ت بیشتری از مدار فراهم میی جزئیا، امکان مشاهدهواحد

 

 واحد اصلی RTLنمای  

                                           
1 ynthesizeS 

2 Run 

3 Syntax 

4 RTL View 
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 با جزئیات RTLنمای  

 Design Objects ofای با نام ی این طراحی، پنجرهی اجزای تشکیل دهندهبرای مشاهده

Top Level Block باشد:تعبیه شده است که دارای چهار بخش می 

 1هانمونه 

شوند. به ده میی طراحی شما در این قسمت به تفکیک نمایش دادهندههای تشکیلبلوک

 ورودیسه  ORدو ورودی، یک  ANDنج بلوک بوده که شامل دو ما دارای پ یکنندهعنوان مثال جمع

 باشد.می XORو دو 

 2هاپایه 

                                           
1 Instances 

2 Pins 
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 کند.های مدار را مشخص میپورت

 1هاسیگنال

ها در شکل ها، مکان آنهای مدار را نشان داده و با کلیک بر روی هر یک از آنسیگنال

 شود. نمایش داده می

 2هاویژگی

 شود.های بالا، جزئیات مربوط آن در این قسمت نشان داده میگزینهبا انتخاب هر یک از 

 

 RTL Viewی طراحی در هاویژگی 

وجود دارد که  1ی طراحیهاخلاصه و گزارشی دیگری با نام ها گزینهفرآیندی در پنجره

                                           
1 Signals 

2 Properties 
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ی گرچه امکان مشاهدهدهد. ابندی شده نشان مینتایج حاصل از سنتز را به صورت خلاصه و طبقه

مقصد  دستگاههای با جزئیات بیشتر نیز در این قسمت وجود دارد. این اطلاعات، از گزارش گزارش

های موردنیاز 2LUTشود. نسبت های تولید شده در طول فرایند سنتز را شامل میهشدارها و خطاتا 

انتخاب شده و بسیاری دیگر از این  دستگاههای موجود در LUTبرای طراحی شما به تعداد کل 

 شوند.های ضروری، در این قسمت نشان داده میگزارش

 

 

هاگزارششمای خلاصه طراحی و  

                                                                                                                            
1 Design Summary/ Reports 

2 Look Up Table 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 پنجمفصل 

طراحی بر اساس  

 شماتیک
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 .پردازیممیای ی کتابخانههاجاد یک طراحی بر اساس اتصال بلوکبه توضیح ای فصلدر این 

افزار های دیگر نرمکنیم تا با این مثال، ویژگیاستفاده می کنندهجمعبنابراین این بار از شماتیک مدار 

ISE ی جدید بسازید چه که پیشتر بیان گردید، ابتدا یک پروژهرا نشان دهیم.  درابتدای کار مشابه آن

، شماتیک انتخاب نمایید. سپس بر روی پروژه HDLبا این تفاوت که نوع فایل اصلی را به جای 

ناسب شماتیک را انتخاب کنید و نام م با انتخاب منبع جدید یک فایل از نوع کلیک راست کرده و

ی  شماتیک به صورتی که در شکل برای فایل خود را وارد نمایید. در نهایت با انتخاب اتمام، صفحه

 آید.نشان داده شده، به نمایش در می 1-2

 

 ایجاد پروژه شماتیک 
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 طراحی شماتیک یپنجره 

جا که دهیم. از آنی آن را کنار هم قرار میاین بار به جای توصیف مدار، اجزای سازنده

سه ورودی برای ساخت رقم  ORدو ورودی، یک گیت  ANDی موردنظر ما به سه گیت کنندهجمع

جمع نیازمند است، برای ساخت حاصل ورودیسه  XORچنین یک گیت خروجی و همنقلی 

درستی کنار یکدیگر قرار گیرند به نحوی که عملکرد صحیح مدار حاصل شود. بایست این اجزا به می

در کدام که المان موردنظر بسته به آنرا انتخاب کرده و  1های نشانهها گزینهبرای انتخاب این المان

 و  AND،ORهای المانمیجا که تماآنافزار بیابید. از ی نرمگیرد، آن را از میان کتابخانهدسته قرار می

XOR  گردیم.ها میبه دنبال آن 2منطقیی آیند، در دستهبه حساب می های پایهجزو المان 

                                           
1 Symbols 

2 Logic 
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 هااز کتابخانه هاانتخاب المان 

ها را ها به تعداد مناسب، ارتباطات مناسب میان آنپس از اضافه کردن هر یک از این المان

های مدار را مشخص نماییم. برای این بایست ورودی و خروجیسازیم. در نهایت نیز میبرقرار می

ها را نیز از را استفاده کرده و ورودی یا خروجی بودن آن Add >  I/O Markerکار لازم است که از 

ها ها را تغییر داده و عنوانی مناسب برای آنمنوی سمت چپ تعیین کنید. سپس نام این پورت

 انجام دهید. 1برگزینید. این کار را با کلیک راست بر روی پورت موردنظر و انتخاب تغییر نام پورت

                                           
1 Rename Port 
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 هاه و خروجیرودیتعیین و 

قرار دارد، ارتباطات را برقرار  2ی ویراستاراز نواری که کنار صفحه 1انتخاب افزودن سیم با

را اجرا کنید. بدین ترتیب  Tools -> Check Schematicکرده و برای اطمینان از صحت اتصالات، 

 توانید در صورت عدم وجود خطا کار خود را ادامه دهید. می

                                           
1 Add Wire 

2 Editor 
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 کنندهجمعایی شماتیک نه 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ششم فصل

 شبیه سازی رفتاری
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تواند این شبیه ساز می سازی رفتاری طراحی نیاز به یک شبیه ساز داریم.برای شبیه

Modelsim  یاISim  اند. در این راهنما با طرز باشد که هر دو از طریق هدایتگر پروژه قابل دستیابی

در نهایت خواهید دید که نتایج در هر دو این  آشنا خواهیم شد.ها کار با هر دو این شبیه ساز

 یکسان است. هاسازشبیه

 ISimشبیه سازی با  -6-1

ی تک بیتی خود را بررسی کنیم کنندهابتدا لازم است تا رفتار جمع ISimسازی با برای شبیه

 Verilog/VHDLتوانید از فایل و از عملکرد درست آن اطمینان حاصل نماییم. بدین منظور یا می

Testbench برای تست مدار خود استفاده نمایید. ما  1که از شکل موجبه این منظور بهره ببرید و یا آن

به جای پیاده  2ی شکل موج استفاده کردیم. بدین ترتیب در قسمت نمابرای تست این مدار از گزینه

ی در پنجره  ISimساز شود تا شبیهرا انتخاب کردیم. این کار سبب می  سازیشبیه ی، گزینه3سازی

ی جدیدی گشوده ، صفحه4سازی رفتاری مدلنتخاب شبیهمربوط به فرآیندها به نمایش درآید. با ا

ها را نیز، فراهم های داخل مدار شما را نشان داده و امکان تغییر این سیگنالسیگنالمیشده که تما

 کند. می

های میانی کنید، سیگنالمشاهده می _XLXNهایی که با لازم به ذکر است که سیگنال

سه  ORو  ANDهای ها مابین گیتگذاری کرده است. این سیما را نامهافزار آنباشند که خود نرممی

                                           
1 Waveform 

2View 

3 Implementation 

4 Simulate Behavioral Model 
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 دهد. را نشان می ISim، محیط  1-6قرار دارند. شکل  ورودی

 

 ISimمحیط  

ISim (ISE Simulator) باشد که افزار میهای توصیف سختبرای زبان شبیه ساز، یک

ها را به لحاظ و یا ترکیبی از زبان  VHDL، Verilogهای نوشته شده به زبان سازی طراحیامکان شبیه

 کند. چنین عملکردی )رفتاری( فراهم میزمانی و هم

کنیم. ی خود را تست میکننده، مدار جمعVerilog Testbenchحال با استفاده از یک فایل 

 کنیم. بدین منظور مشابه زیر رفتار می

Project -> New Source -> Verilog Test Fixture   

 را اتمامی بعدی رفته و در نهایت سپس نام فایل مورد نظر خود را وارد کرده و به مرحله

شود به آورده می  Verilogهای زبان برای فایل Test Bench. بدین ترتیب قالب کلی کنیممیانتخاب 

ی میان شود. در بازهنیز تشخیص داده می رهای مدااز فایل گرفته شده و پورت نمونهاین معنا که یک 
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"begin"  و"end"  را با مقادیر موردنظر خود،  ورودیهای ، سیگنال1مقداردهی اولیهدر بلوک

 .شودمشاهده  های خروجیتا در نهایت مقادیر سیگنال کردهمقداردهی 

را اجرا کرده تا از عدم  ISim Simulator->Behavioral Check Syntaxپس از مقداردهی، 

 .خطا در کد خود اطمینان حاصل شود وجود

 . کنیممیرا اجرا  رفتاری مدل سازیشبیهسپس 

 Modelsimسازی با شبیه -6-2

را نیز  Modelsim افزارنرمباید  ISE افزارنرمعلاوه بر نصب  Modelsimسازی با برای شبیه

یی که شامل اطلاعات مختلف از جمله هاکنابخانهروی کامپیوتر خود نصب نمایید.در قدم بعدی باید 

سازی پروژه شما استفاده لاعات برای شبیهاز این اط Modelsimسازی کنید. بندی است را شبیهزمان

را بدهید.  هااجازه دسترسی به این کتابخانه Modelsimکند. برای انجام این کار در ابتدا باید به می

لازم است به صورت دستی متغیر مربوط بنابراین گیرد. اتوماتیک صورت نمیاین عملیات به صورت 

را یافته و با   modelsim.ini، فایلModelsimقبل از این کار در مسیر نصب به آن را تنظیم کنید.

خارج کرده، در  2ها، آن را از حالت خواندنکلیک راست کردن روی آن و رفتن به بخش ویژگی

 3برای تنظیم متغیر، روی پنجره کامپیوتر منن یک کپی از فایل را نگه دارید. سپس نهایت برای اطمینا

 را انتخاب کنید. هاکلیک راست کرده و گزینه ویژگی

                                           
1 Initialize 

2 Read Only 

3 My Computer 
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 هاانتخاب ویژگی 

 را انتخاب نمایید. 1ی سیستمی تنظیمات پیشرفتهسپس گزینه

 

 

 سیستمانتخاب تنظیمات  

                                           
1 Advanced System Setting 
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 سپس روی متغیرهای محیط کلیک کنید. 

 

 های محیطمتغیر 

را به  modelsim.iniرفته و ویرایش را بزنید. سپس مسیر فایل  Pathدر ادامه روی متغیر 

 مقدار متغیر اضافه کنید.



 سازی رفتاری: شبیهششمفصل                                             ISEراهنمای استفاده از نرم افزار 

 

 

45 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 

 Pathتنظیم متغیر  

کامپایل  ISEها را از طریق هدایتگر پروژه پس از انجام این کار باید یک بار تمام کتابخانه

 را طی کنید. کنید. برای این کار مراحل زیر

 ی ساز نسخهتعریف پروژه هستید، در بخش تعریف پروژه برای شبیه یاگر در مرحله

Modelsim .نصب شده روی کامپیوترتان را انتخاب کنید 
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 سازانتخاب  شبیه 

را انتخاب نموده و پس از تعریف پروژه تصمیم به  ISimساز اما در صورتی که در قبلا شبیه

 تغییر دهید. Modelsimساز را به شبیه Project > Design propertiesتغییر آن داشته باشید از مسیر 

رفته و آدرس فایل اجرایی   Integrated toolsبه  Edit > Preferencesسپس از مسیر 

Modelsim ساز وارد کنید.را در بخش شبیه 
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 ISEبه  Modelsimمعرفی  

سازی را به گزینه پیاده ،در پنجره طراحی، بخش نماپس از این مرحله در هدایتگر پروژه 

  1ساز تغییر دهید. سپس در حالتی که فابل پروژه انتخاب شده است، در بخش مصارف طراحیشبیه

سازی شود. شبیه هادوبار کلیک کنید تا کتابخانه 2HDLی شبیه سازی هاروی عبارت کامپایل کتابخانه

 8-6این عملیات ممکن است از نیم تا چند ساعت طول بکشد. در نهایت تصویری مانند شکل 

و خطاهایی موجود باشد، آنها را نادیده گرفته و  هاسازی هشدارخواهید دید. ممکن است پس از شبیه

 بعد بروید. یبه مرحله

                                           
1 Design Utilities 

2 Compile HDL Simulation Libraries  
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 هاکتابخانهسازی شبیه 

نوشته شده برای طراحی را به پروژه اضافه کرده و با انتخاب آن، روی  Testbenchدر نهایت 

باز خواهد شد و   Modelsimبروید. با دو بار کلیک کردن روی آن  سازی رفتاری مدلگزینه شبیه

 شود.میمنتقل  Modelsimسازی به عملیات شبیه
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 Modelsimسازی با شبیه 

 

  Modelsim یاز پنجره شمایی 

تنظیم متغیر، توجه کنید تمام این عملیات یک بار باید طی شود. برای دفعات بعدی نیاز به 

 سازباید در تعریف پروژه شبیهکامپایل کتابخانه نیست و تنها و  ISEبه  Modelsimمعرفی 

Modelsim  سازی ی آخر که شبیهمرحلهانتخاب شده وTestbench  باModelsim  ،انجام شوداست. 

 



 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 هفتم فصل

 سازیپیاده
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 Bitstreamو تولید فایل  4، مسیر یابی3، جایابی2، ترسیم1سازی فرآیندی شامل ترجمهپیاده

سازی بروید و در طراحی، روی نمای پیاده یبرای مشاهده جزئیات پیاده سازی باید در پنجره است.

فرایندها دو زیر بخش سنتز و پیاده سازی قرار دارد که با اجرای هر بخش از درستی طراحی  یپنجره

شوید. این تفاوت با شوید و یا از خطاهای طراحی آگاه میمطمئن می هادر هر کدام یک از بخش

 شود.علامت ضربدر یا تیک برای هر بخش مشخص می

 

 فرآیند سنتز و طراحی بدون خطا 

های مختلف از جمله فرکانس توانید به گزارشمیبا کلیک روی هر بخش از خلاصه طراحی 

 دست یابید. FPGAساعت مدار و تعداد منابع مورد استفاده از 

سازی شامل بخض های مختلفی است که در اینحا و بخش مهم یعنی اختصاص پایه و پیاده 

                                           
1 Translate 

2 Map 

3 Place 

4 Route 



 سازیهفتم: پیادهفصل                                                       ISEراهنمای استفاده از نرم افزار 

 

 

16 Copyright © 2013 ICEEP, University of Tehran                                                            

 

 ریزی روی برد را توضیخ می دهیم.برنامه

 تخصیص پایه -7-1

منبع جدید را  یا با راست کلیک روی پروژه گزینهابتد برای انجام عملیات تخصیص پایه

و  اصلیانتخاب کرده و آن را با نام منبع  1اضافه کرده و یک فایل از نوع فایل محدودیت پیاده سازی

 سپس گزینه بعدی و اتمام را برگزینید.ذخیره کنید. ucf.پسوند 

 

 تولید فایل پیاده سازی 

 Floorplan I/Oروی  هااصلی انتخاب شده است، در پنجره فرآیند سپس در حالتی که منبع

Logic .دو بار کلیک کنید 

                                           
1 Constraints FileImplementation   
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 Floorplanباز کردن  

پنجره   Layout > I/O Planning شود. از طریقمیباز  PlanAheadبا انجام این کار پنجره 

Package .را باز کنید 

 

 Packageپنجره  
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به صورت اتوماتیک  Tools > I/O Planning > Auto-Place I/O Portsسپس از طریق 

 هاپایهتوانید با داشتن اطلاعات مشخص مکان میدر این مرحله  را انجام دهید. پایهعملیات تخصیص 

 را به صورت دستی تعیین کنید.

 

 پایهتخصیص  

خارج شوید. با انجام این کار  PlanAheadرا بزنید و از  File > Save Constraintsدر نهایت 

ها، علامت سوال وجود دارد. این به این سازی طراحی در پنجره فرآیندبینید که کنار عبارت پیادهمی

 دچار تغییر شده است و باید پیاده سازی را یک بار دیگر اجرا کنید. ucfدلیل است که فایل 

ها در پایهاختصاص  ینحوهکنید تا  را انتخاب 1پایهدر این مرحله از خلاصه طراحی گزارش 

FPGA .را مشاهده کنید 

                                           
1 Pinout Report 
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 پایهگزارش  

 برد 1ریزیبرنامه -7-2

ابتدا سیم  برای این کار .برد می رسد ریزیپس از عملیات تخصیص پایه نوبت به برنامه

ی منابع روی گزینه در حالی که در پنجره ریزی از کامپیوتر را به برد وصل کنید.سپستغذیه و برنامه

یندی اید، در پنجره فرآیند ها روی عبارت هیئتسازی قرار دارید و فایل اصلی را انتخاب کردهپباده

باز خوهاد شد. از مسیر  ISE iMPACTدو بارکلیک کنید. در ادامه این کار پنجره  2دستگاه مقصد

File > New Project   را تایید  کنید. در این قسمت پیام تولید اتوماتیک پروژهپروژه جدیدی ایجاد

را مطابق  JTAGبندی با ی هیئتای مانند شکل زیر باز می شود که باید گزینهادامه صفحهکنید. در 

با زدن  و ... را انتخاب نمایید. شکل انتخاب کنید و در کادر پایین آن گزینه اتصال اتوماتیک به سیم

 می شود. تایید پنجره بسته

                                           
1 Program 

2 Configure Target Device 
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 بندیتعیین نوع هیئت 

 ای مشابه شکل زیر را مشاهده خواهید کرددر این مرحله پنجره

 

 

 iMPACTپنجره کار  
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را انتخاب کنید  Xilinx 1روی بخش سفید پنجره راست کلیک کرده و گزینه افزودن دستگاه

 را انتخاب و باز کنید. Full_Adder.bitو در پنجره باز شده فابل 

 

 دستگاه انتخاب 

راست  Xilinxپس از این کار تصویری مشابه شکل زیر مشاهده خواهید کرد. روی دستگاه 

کلیک کرده و برنامه ریزی را انتخاب کنید. در نهایت در صورتی که مشکلی وجود نداشته باشد. 

 آمیز بودن برنامه ریزی به شما اطلاع داده خواهد شد.موفقتعبارت 

                                           
1 Add Device 
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 مقصد ریزی روی دستگاهبرنامه 

آشنا شدید و می  ISEرسد. شما تا اینجا با عملیات پایه ای در در این مرحله کار به اتمام می

برد آن را تست کنید. برای کسب اطلاعات بیشتر می توانید  یتوانید سخت افزار خود را طراحی و رو

 مراجعه کنید. www.ICEEP.irبه سایت 

http://www.iceep.ir/


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 نامهواژه
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A 

Add Device   دستگاه  افزودن                                                                     

Add Source                                                                                 افزودن منبع 

Add Wire                                                                                    افزودن سیم 

Advanced System Setting  ی سیستم         تنظیمات پیشرفته                   

B 

C 

Cancel                      لغو 

Comment Block Template قالب بلوک توضیحات 

Complile HDL Simulation Libraries  

سازی توصیف کامپایل کتابخانه های شبیه

 افزار   سخت

Configure Target Device دستگاه هدفبندی هیئت 

D 

Device                         دستگاه 

Design Summary/ Reports  های طراحیخلاصه و گزارش 

Design Utilities               مصارف طراحی 

E 
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Editor ویراستار 

F 

Finish اتمام 

Full Adder کنندهجمع 

G 

H 

Hardare Design Level افزارطراحی در سطح سخت 

I 

Implementation                                                                             پیاده سازی 

Implementation Constraints File     سازیفایل محدودیت پباده 

Initialize                                                                                 مقدار دهی اولیه 

Instances نمونه 

J 

K 

L 

License مجوز 
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Logic منطقی 

M 

Map                                                                                                  ترسیم 

Module Statement                                                                          شرح واحد 

My Computer                                                                               کامپیوتر من 

N 

New Project  ی جدید                                                                            پروژه 

New Source                                                                                  منبع جدید 

Next بعدی 

O 

Others غیره 

P 

Pin                                                                                                       پایه 

Pinout Report  ها                   گزارش پایه                              

Place  جایابی                                          

Process  فرآیند                                       

Program                                      ریزیبرنامه 
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Project                                                                                                پروژه 

Project Commands                      دستورات پروژه 

Project Navigator Interface            واسط هدایتگر پروژه 

Property  ویژگی 

Q 

R 

Read Only                                        فقط دارای قابلیت خواندن 

Register Transfer Level  سطح انتقال ثبات                 

Rename Port                                تغییرنام پورت 

Route                                                                                             مسیریابی 

RTL View                                   نمای سطح انتقال ثبات 

Run                                                                              اجرا کردن                 

S 

Schematic  شماتیک                                  

Signal                                                                       علامت، سیگنال 

Simulate Behavioral Model            سازی مدل رفتاریشبیه 

Simulator                                    سازشبیه 
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Source                                                                                                 منبع 

Symbol                                                                                               نشانه 

Syntax                                                                                                 نحو 

T 

Top-Level Design                        سطح بالا)بالاترین سطح طراحی( طراحی 

Transcrip                                                                                        رونوشت 

Translate  ترجمه                                     

U 

V 

View نما 

W 

Waveform                                    موجشکل 

Workspace فضای کار 

X 

Y 

Z 

                        


